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Calendar 
 

November, 2003 
 

 4 PCR: 7:00 pm 
 

 5 Print night: 7:30 pm  
  Judge: Gary Landsman 
  Hospitality: Ann Jorgenson, Susan  
   Sanders, and Stuart Mathison. 
 

 12 Board Meeting: 7:30 pm; Hoffman’s. 
 

 16 Field Trip: National Zoo. 
 

 18 Slide Critique:7:30 pm, Kent Mason’s. 
 

 19 Slide night: 7:30 pm; 
  Judge: Marshall Dupuie. 
  Hospitality: Jan Treat, Henry Maines, 
   and Colin Bennett. 
  Gallery: Marianne Davis. 
 

 20 Visual Design:7:30 pm , Kent Mason’s. 
 
 

December, 2003 
 

 2 PCR: 7:00 
 3 Print night: 7:30 
 10 Slide night: 7:30 
 15 Board meeting: 7:30, Ross Emerson’s 
 16 Slide Critique: 7:30 Kent Mason’s 
 18 Visual Design: 7:30 Kent Mason’s 
TBD Field trip: DuPont Circle 
 

 

Competition Assignment: 
 

Tools and Machines 
 

One or more tools and/or ma-
chines (or parts thereof) must be 
both a large portion and the key 
elements of the image. (Must have 
been taken on or after June 1, 
2002.) 
 
Please note: November’s slide night 
is on the third Wednesday rather 
than the usual second Wednesday. 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 

 

Gary Landsman to be 
Print Night Judge 

 

Shooting for more than 20 years, 
now with a studio in Baltimore, 
(StudioBaltimore.com) and offi-
ces in Washington DC, Gary 
shoots commercial lifestyle. His 
work appears in corporate publi-
cations, annual reports and 
advertising for clients including 
ICF Consulting, Verizon, USAIR-
WAYS, and Harrah’s. Gary now 
shoots both traditionally and with 
new digital capture.  

=================================== 

Bring a Guest to 
Program Night 

 

This year we introduced the con-
cept of “Program Night” where we 
invite a guest photographer to 
give us a presentation of some 
skill or technique they’ve mas-
tered that would be of interest to 
our members.  
 

We are hoping to have good 
turnouts for our guest presenters. 
Consider bringing a photographer 
friend with them to these 
meetings. 
 

Our first program night with Carla 
Steckley was a huge success. 
Carla presented some of her 
infrared images, both in print and 
slide format, and then gave us 
some tips on how to take 
successful infrared photos. Inter-
est by members was demon-
strated by the large number of 
very good questions generated 
by the audience.  
 

Marshall Dupuie is Slide 
Night Judge 

 

Marshall has lived in Frederick for 
the past 28 years but grew up in 
northern Michigan. After serving 
in the Air Force, he earned a 
Bachelor of Arts degree from 
Michigan State University and a 
Masters of Business Administra-
tion from Wayne State University 
in Detroit. His professional career 
was in financial planning services 
from which he retired in 1995. He 
also operated a portrait photo-
graphy business in Frederick for 
many years. 
 

His deep interest in photography 
goes back some 25 years. He is 
mostly self-taught but along the 
way he took a number of 
classroom and workshop cour-
ses. He operated his own dark-
room for about 20 years, howe-
ver, over the last two years al-
most all of his photographic out-
put has been digitally generated.   
 

He doesn’t compete in photo 
competitions anymore. When he 
did, he received many awards 
from local and regional compe-
titions, including the Best of Show 
at the 62nd and 63rd Cumberland 
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Member Profile 
 

Mark Segal 
 

 
 

Photography became part of 
Mark Segal’s relaxation regimen 
because he had to learn dark-
room procedures for his profess-
ional life. While earning a doctoral 
degree at the University of Mass-
achusetts at Amherst, his work in 
microbiology required using and 
processing glass photographic 
plates. He’s originally from Chica-
go’s North Side and thus a long-
suffering Cubs fan. 
 

About his first camera, Mark said, 
“An uncle gave me a Sears 
Roebuck version of the Ricoh 
Singlex he probably picked up 
from a used equipment dealer. It 
was a heavy thing with a loud 
shutter, some lousy lenses, but it 
worked.” He added, “I was in grad 
school, living in Amherst with the 
wonderful scenery everywhere, 
so I started taking pictures.” 
 

A friend recommended that he 
join a camera club. Amherst is 
the site for the annual seminar 
put on by the New England 
Council of Camera Clubs. As 
Mark said, “Not only did I get into 
a good club, but for a couple of 
years I had a chance to help in 
running that show and free 
access to the presentations. 
That’s how my interest in photo-

graphy started and grew in the 
late 1960s.”  
 

After teaching for a time at a 
community college in Ohio and 
working at the state School of 
Public Health in Chicago, he 
came to the Washington, DC, 
area to work with the 
Environmental Protection Agen-
cy. Currently, Mark is a senior 
scientist working in EPA’s bio-
technology program. He deals 
“with some of the commercial and 
industrial applications of biotech-
nology, regulating their environ-
mental safety. He analyzes pro-
ducts to make sure they’re in 
compliance with EPA regulations 
and that they are relatively be-
nign.” He also works in harmo-
nizing national and international 
regulations and does some scien-
tific research related to this area. 
 

About 1984, Mark joined North 
Bethesda Camera Club, and 
credits the competitions and 
programs with improving his 
photographic skills. He usually 
migrates towards nature photo-
graphy, particularly almost ab-
stract close-ups of colorful crit-
ters, insects, wildflowers, moss 
and lichen. Because of the limita-
tions of his equipment, he’s not 
into bird photography.  
 

As the unofficial computer guru at 
work, he’s conversant with 
PhotoShop and hopes to begin 
producing quality prints from his 
slides. Mark spends about 25 
percent of his free time on 
photography. He tends to 
emphasize architectural details, 
photojournalism and candid por-
traits when on vacation and bus-
iness travel. Because of time lim-
itations, he always thinks about 
shooting for slide essays while on 
travel and has produced a num-
ber of programs for the club’s 
annual event.  
 

“I’m really not adept at posed 
people photography,” he said. “I 
prefer capturing moments of 
people pursuing their normal 
activities where I finds them.” He 
added, “I try for pictures that 
reflect the cultures of the places I 
visit because of my work. I’m 
reluctant to draw attention to 
myself. Most people don’t mind 
my photographing them. Natu-
rally, if they indicate any reluc-
tance to being photographed, I 
move on to other subjects.”  
 

Currently, Mark shoots with Nikon 
N70 and F80. In his view, the 
N70, while having a number of 
good features, is not oriented to 
an advanced user. The F80 has 
better features for the kind of 
work Mark wants to do, allowing 
him to check the depth of field. 
With both cameras he uses 
lenses in the 60 ~ 300mm range 
and a 1.4 teleconverter so he can 
get close-ups without getting 
close up. 
 

On travel, he usually takes the 
F80 with two lenses and the 
teleconverter. His preferred films 
are Fujichrome Sensia, Provia 
and Velvia. Mark’s choice of film 
is sometimes a function of 
NBCC’s competition categories. 
He enjoys doing the assignments 
because “they challenge me to 
shoot things I might not otherwise 
consider and learn techniques I 
had not previously used.”  
 

As a result of the classes given 
by Kent Mason, Mark said, “I 
almost always carry a tripod or a 
monopod no matter where I’m 
shooting.” On travel he uses a 
Cullman travel tripod that he 
bought at a club auction several 
years ago. 
 

Text and photo by Joe Razza  
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Marshall Dupuie (continued from p.1) 
 

Valley Photographic Salon, a highly competitive re-
gional competition hosted by the Washington Coun-
ty Museum of Fine Arts.  
 

He is active in local art organizations and served on 
a number of boards and committees for these 
organizations. He served as the President of the 
Frederick County Art Association and for a number 
of years was on the Executive Board of the 
Delaplaine Visual Arts Education Center in 
Frederick. He is currently the President of the 
Frederick Camera Clique, an organization that he 
founded in 1985. He is also a part-time (contract) 
photography instructor at the Frederick Community 

College, and teaches black and white photography 
darkroom classes at the Delaplaine Visual Arts 
Education Center. He also judges local and regional 
photography competitions. He is certified by the 
Maryland Association of State and County Fairs, 
Inc. as a photography judge. 
 

He and his wife travel extensively and he presents a 
slide program about their travels to art and civic 
organizations. He is in the process of building a web 
site dedicated to travel photography that can be 
viewed at www.photobite.com. 
 

Ted Oberman 
 
 

================================================================================================================ 
Hoppy and Polly visit PCR 
 

At the October meeting of the Potomac Community 
Resources (PCR) Phabulous Photographers a 
bunny rabbit and a parrot made special appear-
ances. The goal was to give the students a chance 
to photograph live animals in a studio setting. 
NBCC club members provided and set up studio 
lighting and backdrops for the PCR photographers.  
 

 
Polly sits for a student Hoppy enjoys a carrot. 

 

 
Polly studies the student. 

 
Ruth Hanessian 

 

Several of the PCR students brought their own 
cameras and took advantage of the photo 
opportunity. Both Hoppy and Polly were coaxed to 
sit pretty for the cameras through the use of carrots 
as a reward. All in all a very enjoyable time was 
had by all. Thanks to Joe Razza for coming up with 
the idea and arranging for the shoot and to Ruth 
Hanessian of the Animal Exchange for bringing the 
models. As a reminder, the NBCC PCR group is 
always looking for new participants to help at the 
monthly meetings. It is a very rewarding experience 
and there’s always room for new members. The 
meeting is held at the 622 Hungerford Drive, Suite 

8, (in the rear) right next to the Asia Bank Building. 
For more information contact Joe Razza at 301-
340-6352. 
===================================================== 
E-Mail thoughts 
 

At a recent NBCC Board meeting thee was some 
discussion about delivery problems in e-mail. When 
sending e-mails, return messages were being 
received stating that the message was undelivera-
ble. This can be due to a “full” mailbox. Most e-mail 
services allow a certain size of Megabytes for mail 
storage, including all folders (inbox, sent receipts, 
drafts, etc.). You should check this status and if you 
are at, or near the limit you should perform some 
housekeeping.  
 

This could include deleting messages you no 
longer need and transferring larger files, that may 
include large attachments (photos, notices, etc.), to 
your local hard drive. One approach for this is as 
follows: First create a directory on your hard drive 
where you will store these attachments. Then, 
when you open an attachment in your e-mail, there 
is usually an option that says something like “would 
you like to open the file or save it to your 
computer?”. When you pick the “Save” option you 
are usually presented a list of your files. You would 
navigate to the directory you previously created. 
Then simply select the “Save” option and this file 
will be saved on your hard drive. You could now 
delete the large e-mail message from your e-mail 
storage. Doing this for several messages with large 
size attachments should free up a lot of space so 
that you can receive new e-mails without rejection. 
If you have any questions on this approach, I would 
be glad to help as much as I can.  
 

Tom Sullivan 
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Converting Color to Black and White 
 

What is the best digital method to produce a black 
and white image from a color image? There are 
several ways to do this in Photoshop, but the best 
method may depend on the image you’re con-
verting. A grayscale image consists of black, white 
and grays that range from light to dark. Its contrast 
is based on changes in brightness or luminosity. 
The contrast in a color image may come from 
differences in brightness, but may also come from 
differences in hue and saturation. Complementary 
colors like red and green provide hue contrast, but 
may not vary in brightness. This type of color image 
may need a different conversion method than one 
where the impact is from contrast in brightness. 
 

Here are different ways to change your color image 
to grayscale using Photoshop. 
 

1. Switch Mode.  From the Menu select Image > 
Mode > Grayscale. All color information will be 
discarded and you will have a grayscale image. 
Frequently the resulting image may look flat. 
You can then boost the contrast, but you can 
lose tonal detail doing that. 

 

2. Lab Mode Conversion.  From the Menu select 
Image > Mode > Lab Color. This separates the 
image into a Lightness channel, A channel, and 
B channel. (View the Channel Palette by 
selecting Windows > Show Channels.) Click on 
the Lightness channel to select it. Then copy 
this channel and paste it into a new document. 
This will be your grayscale image. (To copy and 
paste do this: With the Lightness channel high-
lighted, from the Menu click Select > All; Edit > 
Copy; File > New; Edit > Paste.)  The results of 
this conversion should give better contrast than 
the simple grayscale mode change. 

 

3. Channel Mixer. From the Menu select Image > 
Adjustments > Channel Mixer. Check the Mo-
nochrome box at the bottom of the window and 
make sure that Preview is checked. Move each 

of the sliders to adjust your image. Initially red 
is set to 100% and Green and Blue are set to 
0%. You should try to keep the total of the red, 
green, and blue values to around 100. The 
Constant slider at the bottom adjusts the 
brightness. This conversion method gives you 
the most control. You can even simulate the 
effect of different filters, by adjusting the color 
sliders. 

 

4. Hue/Saturation.  Select Image > Hue/Satura-
tion. Make sure there is no check in the 
Colorize box. Drag the Saturation slider to the 
left (-100); Hue and Lightness should be left at 
0. This method is similar to Lab Mode 
Conversion. It does not let you make any 
adjustments that depend on the colors of the 
image. 

 

5. Photoshop Plugins.  There are plugins avail-
able for purchase that will make your conver-
sion from color to grayscale easier and will also 
give you options to mimic different B&W films 
and film filters. Here are a few: 

 

• Convert to B&W ($40) and Convert to B&W 
Pro ($99) from Imaging Factory 
(http://www.theimagingfactory.com). 

• Black and White Studio ($75) from Power 
Retouche (http://www.powerretouche.com) 

 

Before printing your image, make sure it is in the 
correct mode. Convert back to RGB if you are 
printing on an inkjet using the normal print drivers. If 
your system is “calibrated”, you will get the best print 
by using all the colors, even for a grayscale image. 
When you leave the image in grayscale mode, only 
the black ink is used for printing and you don’t get 
the full range of tones. (If you use the “Piezography” 
method of printing black and white images, you 
must have your image in grayscale mode.) 
 

Sue Oberthaler 
 
 
 

 

================================================================================================================ 
Hawkins Takes Pix After Isabel 
 

Jim Hawkins took to the C&O Canal, Great Falls 
area soon after the passing of Hurricane Isabel. The  
 

 
Spider web 

 
Family of spider webs 

 

rainy and foggy weather was too much for Jim to 
pass up. He captured a variety of fine shots on his 
outing. As you can see, Jim does excellent work! 
 
 

 
The Potomac is swollen 

 
A lonely stroller on the Canal 
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Field Trip – National Zoo – Sunday, Nov. 16th
 

 

We’re going to test the validity of the adage: The 
third time’s a charm. We’re doing this by scheduling 
a trip to the National Zoo for the third time in two 
years. The previous efforts to go to the zoo were 
ruined by bad weather. This time, however, NBCC 
has a backup plan to thwart all but the most severe 
bad weather. More about that later.  
 

The plan is to meet at 8 a.m. at the Picnic Pavilion 
adjacent to the Mane Restaurant, near Parking Lot 
D, just off Rock Creek Parkway. If you’re driving, 
you can enter the zoo from Connecticut Avenue and 
follow the road to Parking Lot D or enter the zoo 
from Rock Creek Parkway and drive to the parking 
lot. 
 

The photographic opportunities are spectacular and 
innumerable. Practice using your long lenses on the 
lions and tigers or monkey and gorillas; perfect your 
macro technique on poison frogs, vegetation and 
other small scale flora and fauna; or try your hand at 
action shots with some of the fast moving birds and  

 

 
 

 
 

 
 

 
animals. The zoo is an excellent place to hone your 
street shooting and photojournalistic skills by focus-
ing on the people who work at or visit the zoo. 
 

To prepare for your photo expedition, you can visit 
the National Zoo’s website at natzoo.si.edu or go to 
Goggle and type in National Zoo. We will meet at 
11:30 and go to lunch at Uno Chicago Grill Restau-
rant at  3501 Connecticut Avenue, NW. 
 

Now for the back-up plan: If the weather is 
inclement or too cold for outdoor activities, we will 
meet at 10 a.m. at the Museum of American History, 
14th Street, NW and Constitution Avenue, to see an 
exhibit of Diana Walker: Photojournalist. The exhibit 
features images from the public and private lives of 
U.S. presidents and their families. Please be aware 
that parking in the area of the museum is quickly 
filled by other tourists, so plan on arriving very 
early to get a convenient parking place. If you’re a 
resident associate member, there is free parking in 
the lot next to the Museum of Natural History. You 
need your membership card and driver’s license or 
other acceptable identification to use that lot. 
 

The exhibition includes 135 black-and-white and 
color photographs taken between 1975 and 2001, 
covering five administrations. They were taken in 
the oval office, in the first family’s private quarters, 
on the campaign trail, and during trips in this country 
and overseas. Many of the images are accompanied 
by Walker’s reminiscences and commentaries on 
the pictures. 
 

After viewing the exhibit, we can go for lunch at the 
Main Street Cafes in the lower level of the museum 
to choose from a variety of foods to satisfy most 
palates. For additional information contact Joe 
Razza at 301-340-6352.  
 

Text and Photo by Joe Razza 
 
 

================================================================================================================
Congrats to Northern Virginia Photographic 
Society (NVPS) 
 

NVPS has received the top Camera Club award in 
the Nature's Best Magazine 2003 International Pho-
tography Awards Contest. Nature's Best Foundation 
has created one of the most respected and visually 
compelling nature photography competitions in the 
world. The awards ceremony was held at the 
Smithsonian Museum of Natural History on October 
21, 2003. The Smithsonian will exhibit the winners 
of the 2003 Nature's Best International Photography 
Awards program. 
 

 
 

NBCC President Recognizes NVPS Award 
 

Bob Peavy, president of the NBCC, sent a letter to 
the Northern Virginia Photographic Society (NVPS) 
congratulating them for winning the Nature’s Best 
Camera Club competition for 2003. In the note Bob 
wrote, “…this award is a distinct honor and a de-
served recognition of an accomplished camera 
club”. Additionally, Bob commented  “The NVPS has 
long been known as an accomplished club, with 
strong leadership and enormous talent and crea-
tivity”. Mary Ann Setton, President of NVPS, re-
sponded to Bob’s letter thanking him for his 
thoughts and included the following comment:  “We 
are very proud of the Club award and thank you for 
taking the time to recognize us also. It's like recei-
ving two!” 
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NBCC Videotape Lending Library 
 

In the summer of 1999, with the blessing of the NBCC Executive 
Board, Kent Mason acquired some John Shaw instructional video 
tapes as the first step in the development of the NBCC videotape 
lending library. Several additional tapes have been added, mostly in 
the Nikon and Photoshop series. A complete list of the available tapes 
is in the following table: 
 

VHS Tape Title Sponsor 
Photo Retouching Photoshop 
Creating Great Grayscale Images Photoshop 
Color Correction Made Easy Photoshop 
Layers Techniques Photoshop 
Selection Secrets Photoshop 
Selections Photoshop 
Night Photography Photoshop 
Photoshop for Beginners Photoshop 
Masters of Wildlife, Frans Lanting Nikon School 
Masters of Action, Various photographers Nikon School 
Masters of Photojournalism Nikon School 
Essence of Light Nikon School 
Master of  Portraiture Nikon School 
Masters of Action Nikon School 
The Photographers National Geographic 
Understanding Exposure John Shaw 
Field Techniques and Professional Tips John Shaw 
Effective Composition (Part 1) John Shaw 
Successful Close-ups John Shaw 
Identifying, Organizing and Marketing your work John Shaw 
Nature Photography John Shaw 
Advanced Close-ups John Shaw 
Effective Composition (Part 2) John Shaw 
On Location with Art Wolfe  
Creative Outdoor Photography; Galen Rowell  
 

The tapes can be borrowed for a three-week period by any dues-
paying NBCC member. Presently, Carl Root is the contact person for 
maintaining the library. He will bring the tapes to meetings where 
members can sign them out. If you do borrow a tape, please return the 
tape promptly when it is due so other members can use the tape. 

 

Tom Sullivan 
========================================================================= 
Lens and Eye Is Available On the Website 
 

Remember, members can get the Lens and Eye from the club’s web site, 
http://nbccmd.tripod.com, under the “Newsletter” tab at the top of the opening 
page. There are a couple of advantages of getting the Lens and Eye here: 1) 
You can get it earlier since it is posted as the hard copy is on its way to the 
printer; 2) It is in living color. Many of the photographs seen in color are much 
more impressive.  
 

Additionally, you could decide to obtain your copy of the Lens and Eye from 
the web site every month instead of a hard copy mailed to you. If you want to 
use this approach, please let me know, either by e-mail, phone or at a 
meeting. I will e-mail a notice when the Lens and Eye is posted so that you 
can go to the web site and get it.  

New Book from  
National Geographic 

 

For more than 100 years, Natio-
nal Geographic has set the stan-
dard for nature, culture, and wild-
life photography. Now, in their 
new book, Through the Lens, 250 
spectacular images mostly in 
color — some famous, others 
rarely seen — are gathered in 
one lavish and beautiful volume. 
Through the Lens is divided into 
geographical regions — Europe, 
Asia, Africa and the Middle East, 
the Americas, and Oceans and 
Isles — with a special section 
devoted to space exploration. As 
in the magazine, the society's 
signature blend of dramatic, rigor-
ously composed natural shots 
and "family of nations" style cul-
ture peeps are backed by broad 
captions and text 
 

More than 50% of the photos, 
crisply printed and mostly double-
truck, are from the last 10 years, 
with iconic favorites (like the 1985 
cover portrait of a green-eyed 
Afghan woman and its 1997 full-
burqa reprise) threaded in. 
Weighing in at seven pounds, 
with an initial international printing 
of 375,000 and with an accom-
panying exhibition this fall at the 
society's Washington, D.C., Ex-
plorer's Hall museum, this book 
should make a considerable im-
pression. 
 

Tom Sullivan 
================================= 
 

Change in Assignment. 
 

The NBCC Board has decided to 
change the assignment for De-
cember, 2004, to read as follows:  
Open:  Any photograph taken on 
or after June 1, 1999.  
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Results of Competition for October 2003 – Found Abstracts 
 

Prints 
 

Judge: Clifford Wheeler 
 

Black and White, Novice – 5 entries 
 

1st Roy Sewall Ice Formation #1 
2nd Will Grupenhoff Dunes & Shadows 
 

Black and White, Advanced  - 16 entries 
 

1st Sue Oberthaler Snow on Leaves 
2nd Carl Root Awning 
3rd Chuck Bress Bowling Green Study A&B 
HM Lee Goodwin Fingerprints 
HM Chuck Bress 2 Eyes with Abstract Wall 
 

Color, Novice – 16 entries 
 

1st Richard Huang Kenora Sunset 
2nd Bill Richards Little River Reflections 
3rd Barbara DeLouise Scum on canal 
HM Bill Richards Coils #1 
HM John Grupenhoff Human Genome Bldg 
 

Color, Advanced - 30 entries 
 

1st Carl Root Dumpster rust 
2nd Gordie Corbin Lines in the Shade 
3rd Joe Razza Abstract 101 
HM Dan McDermott Abstract Painting 
HM Anita Van Rooy African Lichen 
HM Cynthia Keith He Formed All Things 
HM Marianne Davis Study in Shape 
HM Marianne Davis Repetition 
HM Marianne Davis Sunrise 
HM Bob Peavy Seattle Art 
 

Altered – 11 entries 
 

1st Anita van Rooy Curtain Material 
2nd Gordie Corbin Isabel 
3rd Gordie Corbin Curves in the Shade 
HM Gordie Corbin Membership Books 
 

------------------------------------------------------------------------------------ 
 

Going to the Smokies, Blue Ridge, or 
Shenandoah? 
 

If you’re planning a trip in that direction, check out 
the videotape from the Potomac Library, National 
Parks of the Appalachians, Great Smokey 
Mountains, Blue Ridge Parkway and Shenandoah, 
Catalog Number 917.6889-GRE. This tape has 
some good suggestions for places to visit in these 
areas and they look like wonderful photo 
opportunities. The best part is you can decide for 
yourself. If it looks like somewhere you think is a 
good photo op, then you can make plans to visit the 
site.  If not, you can skip it.  
 

Tom Sullivan 
 
 

Slides 
 

Judge: Mario Chakkour 
 

Novice – 32 entries 
 

1st Bill Richards Wrapped soda cans #1 
2nd Jin Gong Antelope Slot Canyon 
3rd Sue Milestone Ice reflection 
HM Mike Cline Duron bucket 
HM Mike Cline Midas dumpster 
HM Mike Cline Benjamin Moore 
HM Jean Hanson Blue & Cream II 
HM Barbara DeLouise Rusting can 
HM Barbara DeLouise Reflections 
HM Will Grupenhoff Tree, Central Park 
 

Advanced  - 62 entries 
 

1st Caroline Helou Abstract mood 
2nd Pat Bress Color lines 
3rd Chuck Bress Painter’s pallet 
HM Bob Peavy Green galaxy 
HM Bob Peavy Vegas abstract 
HM Sigrid Vollerthun Dancing rust 
HM Caroline Helou Vintage shape 
HM Caroline Helou Enduring quality 
HM Jim Hawkins Mystery 
HM Carol Lee Canyon #2 
===================================================== 
Release Forms; Are They Necessary? 
 

Many times when members take a photo of another 
person, the question arises about whether a 
“release form” is required to “use” the photograph. 
Issues of privacy must be considered. Following is 
a web site that has a good introductory explanation 
of this situation:  
http://www.apogeephoto.com/mag4-6/mag4-6model_releases.shtml. 
I hope this helps you when considering this re-
quirement. 
 

Tom Sullivan 
===================================================== 
Exhibit of Steve McCurry 
 

Best known for his photograph of a young Afghan 
refugee – whom he tracked down after 17 years 
and rephotographed – Steve McCurry shows a 
collection of shots taken in Asia that give a view 
into people’s spiritual lives. National Geographic 
Society Explorer’s Hall, 17th and M Streets, NW. 
Free. For info:  202-857-7588. 
 

Tom Sullivan 
===================================================== 
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Cumulative Scores for 2003-2004     Hearty Welcome to New Members 
 

Prints 
 

Black and White, Novice 
 

28 Will Grupenhoff 
10 Roy Sewall 
8 Roger Langsdorf 

 

Black and White, 
Advanced 

 

29 Chuck Bress 
20 Lee Goodwin 
16 Sue Oberthaler 
16 Pat Bress 
9 Carl Root 
6 Marianne Davis 

 

Color, Novice 
 

29 Bill Richards 
23 Barbara DeLouise 
20 Richard Huang 
18 John Grupenhoff 
6 Bob Dargel 

 

Color, Advanced 
 

30 Carl Root 
24 Marianne Davis 
14 Joe Razza 
12 Cynthia Keith 
12 Bob Peavy 
10 Jim Hawkins 
9 Gordie Corbin 
8 Carol Lee 
6 Dan McDermott 
6 Roy Sewall 
6 Anita Van Rooy 

 
 

Altered 
 

37 Gordie Corbin 
26 Anita Van Rooy 

9 Jim Hawkins 
6 Bev Gordon 
6 John Grupenhoff 

 

======================= 
 
 

 
 
 
 
 
 
 

 

Slides 
 

Novice 
 

34 Mike Cline 
19 Bill Richards 
18 Barbara DeLouise 
14 Sue Milestone 
12 Jean Hanson 
12 Will Grupenhoff 
9 Jin Gong 
8 Larry Berlin 
6 Shereen Kopp 
6 John Grupenhoff 

 

Advanced 
 

22 Caroline Helou 
18 Pat Bress 
16 Carl Root 
14 Gordie Corbin 
12 Carol Lee 
12 Bob Peavy 
8 Chuck Bress 
6 Anita van Rooy 
6 Ross Emerson 
6 Jim Hawkins 
6 Susan Helzer 
6 Judy Switt 
6 Sigrid Vollerthun 

 
 

 
 

======================= 
 
 
 

 
 
 

 
 
 

 
 
 
 

 

Martha L. Cain-Grady 
5802 Nicholson Lane # 908 
Rockville, MD 20852 
301-881-2366 
 

Ira Adler 
8906 Honeybee Lane 
Bethesda, MD 20817-6925 
301-365-3182 
adlerira@mac.com 
 

Please remember, if you change your e-mail be sure 
to let Gordie Corbin, our membership chairperson, 
know about it. She keeps all the information up-to-date 
so that we may get relevant messages to our mem-
bers. 
 

E-mail change:  Ed Funk of the NVPS has changed 
his e-mail to:  ed@edfunkphotography.com 
 

========================================================= 
Look Sharp, Be Sharp! 
 

Many of you have probably noticed that in the most 
recent club competitions many of the judges have 
been real sticklers for sharpness. Our club members 
produce many high quality images every competition 
night. Sometimes while looking for some reason to 
throw out an image the judge will look very critically at 
the sharpness of the image. This does not mean that 
you must have sharp prints, only a warning that 
recently the judges have been very critical. 
 

========================================================= 
Slide Marking Getting a Little Sloppy 
 

Our slide handlers at the slide night competition have 
noticed that members seem to be getting a little casual 
and sloppy when putting titles and their names on the 
slides. This makes it very tough for our handlers to 
read the name and title correctly in the darkened 
room. We ask that you please pay particular attention 
to making this lettering legible. Thank you in advance 
for your consideration. 
 

========================================================= 
Stuck with only one e-mail? 
 

Did you know there are several sources of FREE e-
mails out there? Some advantages of having more 
than one e-mail are: you can use an alternate if your 
main e-mail goes down; you can use one e-mail for a 
specific purpose, say your travel plans; you could use 
a second e-mail if your main one is full; you could use 
one e-mail for Tim Gray’s DDQ messages. ‘Nuff said; 
here are a few sources for free e-mails: 
 

http://www.juno.com/;       http://www.hotmail.com/ 
http://mail.yahoo.com/;     http://www.netzero.net/ 
 

Good luck. 
 

Tom Sullivan 
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“Digital” Survey 
 

 

The NBCC board would like to improve and/or expand the club’s programs in the digital image capturing 
and processing areas. We have received some preliminary information from the 2003-2004 application 
forms filled out by members. We are asking members who are working in the digital arena to fill out the 
following questionnaire so that we may look at ways to bring members with like interests together and 
construct programs around member’s interests. 
 

Please complete this form and return it by December 5, to Sue Oberthaler either at a club meeting or by 
mail to 9211 Cypress St., Bethesda, MD, 20814-2866. 
 
Name: ____________________________________________________ 

Phone: ____________________________________________________ 

Email: _________________________________________________________  

 

Digital Camera Make/Model (Ex: Canon G1) ______________________________________________  

Computer Type and Model (Ex: Mac G4) ________________________________________________  

Computer Operating System/Version (Ex: MS XP, OS X, OS 9.1) _____________________________  

Image Software Name & Version (Ex: Photoshop 5) ________________________________________  

Film Scanner Make & Model __________________________________________________________  

Flatbed Scanner Make & Model ________________________________________________________  

Photo Printer Make & Model (Ex: Epson 2200) ____________________________________________  

Printer Inks Manufacturer (Ex: Epson, MIS, Lyson) _________________________________________  

Continuous Inking System on Printer? Yes/No ____________________________________________  

Special Printer Software (Ex: ImagePrint, PiezographyBW) __________________________________  

Monitor Calibration (Ex: Monaco Spyder) ________________________________________________  

Digital Projector Make & Model ________________________________________________________  
 

 

Additional Comments/Suggestions: 
 

_________________________________________________________________________________________  

_________________________________________________________________________________________  

_________________________________________________________________________________________  

_________________________________________________________________________________________  

_________________________________________________________________________________________  

_________________________________________________________________________________________  
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2003 – 2004 Executive Board, Standing, and Special Committees 
 

President 
Bob Peavy 
 

Voting Members: 

Vice President 
Sue Oberthaler 
 
Bold and Italic 

Secretary 
Tom Field 
 

Treasurer 
Chuck Lee 
 

Directors 
Jerry Gordon    Joel Hoffman 
Kent Mason     Jim Hammack 
Janet Myder Hammack 
 

 

Program 
Jim Hawkins 
Carol Lee 
Barbara DeLouise 
Andy Gordon 
Bill Richards 
Ted Oberman 
 

Publicity 
Barbara DeLouise 

 

Print Competition 
John Grupenhoff 
Roy Sewall 
Sue Oberthaler 
 

Slide Competition 
Judy Switt 
Jim Hammack 
Ruth Crozier 

 

Hospitality 
Mike Fleming 
Beverly Gordon 
Bunny Ostrower 
Jean Hanson 
Lucia Goldman 
Mark Segal 
Al Goldman 
Margaret Colaianni 
 

 

Membership 
Gordie Corbin 
 

Bulletin Editor 
Tom Sullivan  
 

Exhibits 
Ross Emerson 
Miranda Chin 

 

Field Trips 
Joe Razza 
Chuck Bress 
Dan McDermott 
Cezary Raczko 
 

PSA Representative 
Ruth Crozier 

 

Set-ups 
Tom Field 
Carl Root 
Michael Cline 
Cezary Raczko 
 

Gallery 
Hans Adler 
 

Training Programs 
Kent Mason 
Carl Root 
 

 

 

Webmaster 
Tom Sullivan 
 

Club Equipment 
Jim Hammack 
Tom Field 
Judy Switt 
 

Community Outreach 
Joe Razza 
Joel Hoffman 
 
 
 

 

Church Liaison 
Janet Myder Hammack 
 

Membership Booklet 
Gordie Corbin 
 

Sunshine Committee 
Helen Berkson 
 

Print Night Sales 
Virginia & Jim Render 
 

Slide Night Sales 
Duncan Whitaker 

 

 

Technical Advisors 
Film – Hans Adler 
Digital – Sue Oberthaler 
              Dave Freeman 
 

Competition Image Review 
Joel Hoffman 
Judy Switt 
Kent Mason 
Sue Oberthaler 
 

Awards Dinner Coordinators 
Nancy Peavy 
José Cartas 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


